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Kurzbeschreibung

"Thunderbird" ist eine speziell angepasste Firmware für den Yuneec Typhoon H (auch als H480 
bekannt) auf der Basis vom PX4 Autopilot. Es ist auch ein Synonym für einen Typhoon H, der mit 
dieser Firmware fliegt.

Mit der Thunderbird Firmware kann man eine Menge der Funktionen vom PX4 Autopilot mit einem 
normalen Yuneec Typhoon H (H480) in Verbindung mit der ST16 nutzen. An der ST16 wird nichts 
geändert. Deshalb wird diese in diesem Handbuch auch nicht beschrieben.

Zum Konfigurieren, Kalibrieren und zum Erstellen von Missions brauchen wird das Tool 
"QGroundControl" (QGC).
QGroundControl erlaubt das Einstellungen für alle Parameter. Es gibt dir eine Menge Freiheit, aber 
auch eine menge Möglichkeiten, Fehler zu machen. Du solltest nur das tun, was du auch verstehst.

Tidee und Entwicklung dieser Firmware: Toni Rosendahl.

Die erste Veröffentlichung (mit einer lustig gemeinten Überschrift)  war hier:
https://yuneecpilots.com/threads/typhoon-h-480-px4-v1-10-stability-issues.18205

Das Projekt in GitHub: https://github.com/tonirosendahl/Thunderbird
Dokumentation PX4 Autopilot: https://docs.px4.io/

Die Firmware ist Open Source. Jeder kann mitmachen und wir suchen noch Helfer!

Wichtiger Hinweis:

Du bist verantwortlich für alles, was du tust. Bitte tue nur das, was du verstehst und verantworten 
kannst. 

Lies bitte folgende Beschreibungen:
- PX4 Autopilot: https://docs.px4.io/master/en/index.html
- QGroundControl: https://docs.qgroundcontrol.com/en/

Fliege den Thunderbird nur in freiem, offenem Gelände, abseits von Leuten, Straßen und 
Grundstücken.
Sei immer vorsichtig und verantwortungsvoll.

§   Bitte beachte die in deinem Land gültigen Regeln und Gesetze.  
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Erste Schritte

Mit dem Thunderbird hast du jetzt einen vollkommen neuen Kopter mit unterschiedlichem 
Verhalten verglichen mit den Typhoon H.
Lerne deinen neuen Kopter zu fliegen, übe auch ohne GNSS-Unterstützung zu fliegen. Beginne erste 
Schritte in freiem Gelände, ohne Bäume und andere Hindernisse in der Nähe.

Du brauchst erst einmal nichts an der ST16 zu ändern. Der Thunderbird fliegt mit den Standard-
Einstellungen. Start und Landung gehen am besten im „Hase“-Modus.

Wichtig ist, erstmal zu lesen, wie PX4 Autopilot zu fliegen ist. 
https://docs.px4.io/master/en/flying/

Ein- bzw. Ausschalten

Zum Einschalten musst du den Power-Knopf etwa 8sec drücken bis die Status LED und die LEDs in 
den Motorarmen angehen.
Es kommt kein Einschalt-Tonfolge als Quittung.

Zum Ausschalten musst du die Batterie ziehen. Der Startknopf ist (noch?) nicht zum Ausschalten zu 
gebrauchen.

Motoren starten/stoppen
Starten und Stoppen der Motoren geht nur, wenn der Geschwindigkeitsschieberegler nach oben 
gedreht wurde (auf Hase).

Es funktioniert nicht mit dem roten Knopf an der ST16, sondern mit einem CSC (Combination stick 
command) Kommando wie beim PX4 Autopilot üblich: Linken Steuerknüppel nach unten, rechts 
halten bis die Motoren starten.

Hinweis:
Obwohl es sehr unwahrscheinlich ist, dass das beschriebene CSC Kommando den Kopter in der Luft 
ausschaltet, ist es nicht angebracht den Steuerknüppel im Flug dauerhaft unten rechts zu halten, um 
z.B. spiralförmig abzusteigen.
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Fliegen
In den Standarteinstellungen ist der Flight Mode Schalter folgendermaßen belegt: Oben – Stabilized, 
Mitte – Position (Angle Mode mit GNSS) und untere Schalterstellung – Mission.
RTH, Acro or Rattitude sind nicht vorbelegt. Du kannst aber die Flugmodi deines Wunsches auf die 
Schalter legen. Dazu gibt dir QGroundControl in der Grundeinstellung zwei Möglichkeiten:
- Switch Settings: Zuordnung von Kanälen zu Flight Modes, z.B. Channel 10 (S2: Pan Mode) zu RTH,
- Flight Mode Settings: Zuordnung von Flight Modes zu bestimmten Werten im Kanal 5 (A01).
  Die Werte können in den Channel Settings der ST16 nochmal angepasst werden.

Im Vergleich zum normalen Typhoon H muss folgendes beachtet werden:
• In Position Mode fliegt der Thunderbird weicher. Das ist gut für Videos, aber er bracht auch 

mehr Platz weil der „Bremsweg“ länger als erwartet ist. Du musst vorausschauend fliegen.
• In Stabilized Mode musst du die Höhe selber halten. Der Throttle Stick kontrolliert hier den 

Schub statt der Höhe. Wenn der Schub voll zurückgenommen wird, sinkt der Kopter sehr 
schnell, fast wie freier Fall, also wirklich sehr schnell! Bitte dies beachten.

• Vor dem Umschalten in den Stabilized Mode bitte den Throttle Stick nach unten ziehen. Die 
Motordrehzahl in der Mittelstellung ist höher als in den anderen Flugmodi. Ansonsten kann es 
passieren, dass der Kopter unerwartet steigt.

• In allen Nicht-GNSS-unterstützten Flugmodi verbietet es sich, länger auf die ST16 zu schauen. 
Immer Sichtkontakt zum Kopter halten

• Der Thunderbird ist kein Racekopter auch wenn er schnell und agil ist! Du bewegst ein 
Fluggerät mit etwa 2kg durch die Luft. Es ist wegen der Latenzen beim Video auf der ST16 
kein FPV Flug möglich.

• Nie von  Nicht-GNSS-unterstützten Flugmodi zu  GNSS-unterstützten Flugmodi (Position 
Mode oder RTH) schalten, wenn sich der Kopter schnell bewegt. Er kann dann kein GPS Lock 
erhalten und meldet GPS-Fehler. Er fliegt weiter ohne GPS und kann auch nicht mit RTH 
zurückgeholt werden.
Lass den Kopter an einer Stelle schweben und schalte dann erst um.

• Auf den grünen Richtungspfeil auf der ST16 kann man sich nicht verlassen. Er wird zwar 
angezeigt, muss aber ignoriert werden.

Wichtig:

Sonar (OBS) wird nicht unterstützt und ist immer abgeschaltet. Eventuelle Warnmeldungen OBS 
betreffend kann man ignorieren oder als Erinnerung an diesen Hinweis auffassen.

Die ST16 überwacht nicht den Ladezustand der Flugbatterie. Sie wartet auf Voltage Warning Flags die 
aber vom Thunderbird nicht geliefert werden. Alle Piloten sollten sich das klarmachen und die 
Spannungsanzeige des Kopters auf der ST16 selber überwachen.
Bitte nicht die Flugbatterien bis zum Ende leersaugen. Es ist besser konservativ zu bleiben und den 
Kopter in die Nähe zu bringen, wenn nicht mehr viel Kapazität in der Batterie drin ist.

Bei BAT_EMERGEN_THR (Default 7%) wird der Kopter ohne weitere Warnung da landen, wo er 
gerade ist.
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Sensor Einstellungen und Kalibrierungen

Sensorkalibrierungen können nur mit QGroundControl (QGC) durchgeführt werden. Verbinde den 
Kopter mit  QGC mit einem ausreichend langem, flexiblen Micro USB Kabel.

Achtung: Nach HW-Änderungen, Firmwareupdates oder Parameter-Datei Hochladen immer die 
Kompassausrichtung prüfen und gegebenenfalls neu einstellen.

Einstellen der Kompassausrichtung
Für den Typhoon H gibt es zwei verschiedene Kompasschips, die sich auf dem GPS-Modul befinden. 
Ältere GPS-Module haben den HMC5883 verbaut, neuere den IST8310 als Magnetometer. Um 
herauszufinden, welchen wir haben, müssen wir den Kopter an QGC anschließen und die MAVlink 
Konsole aufrufen:

Eingabe: cd /dev
 ls  zeigt Gerätetreiber und Hardware.

Hier sehen wir entweder "hmc5883_ext" oder "ist8310_ext" als Kompasschip.
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Hinweis: Wenn nicht alle Sensoren aufgelistet sind, USB-Kabel trennen und wieder anstecken und die 
Liste zu erneuern.

Wichtig: Wenn hier "hmc5883_ext" steht, dann muss External Compass Orientation auf 
"ROTATION_YAW_270" eingestellt werden.
Für den "ist8310_ext" muss "ROTATION_YAW_180" eingestellt sein.

Niemals die Autopilot Ausrichtung ändern. Diese muss immer auf "ROTATION_NONE" stehen!

Einstellung: Settings > Sensors > Set Orientation

In „External Compass Orientation“ richtest du die Kompassausrichtung abhängig von der verbauten 
Hardware ein. Speichern und Kopter neu starten, damit die Ausrichtung wirksam wird.
Danach unbedingt Kompasskalibrierung durchführen.

Mehr und detaillitere Informationen siehe hier: 
https://docs.qgroundcontrol.com/en/SetupView/SetupView.html
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Kalibrierungen
Um das Gimbal zu schonen, sollte man zum Kalibrieren die Kamera abziehen.
Zum Kalibrieren brauchen wir QGroundControl. Der Kopter muss mit einem ausreichend langen, 
flexiblen USB-Kabel mit dem Gerät verbunden werden, auf dem QGroundControl läuft.

Menü Settings > Sensors – folge den Anweisungen auf dem Bildschirm für Compass, Gyroscope, 
Accelerometer und Level Horizon. Nie die ESC's kalibrieren. Das geht sowieso nicht und wird auch 
nicht benötigt. Kalibrieren geht nur mit gut geladener Batterie.

Um stabile Positionen für Seiten-, Front- und Hecklagen halten zu können, sollte man passende 
Holzklötze vorbereiten, auf die man den Kopter wackelfrei stellen kann.

Mehr Infos hier: https://docs.qgroundcontrol.com/en/SetupView/sensors_px4.html

Hinweis: Wenn beim Starten immer noch "accelerometer BIAS is too high" kommt, sollte der 
Accelerometer ein zweites Mal kalibriert werden.
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ST16 mit dem Empfänger SR24 im Kopter binden

Wir legen uns zuerst auf der ST16 für den Thunderbird ein neues Modell an. Dieses Binden wir dann 
mit Kopter und Kamera. Bindeprozess für die Kamera CGO3+ funktioniert wie gehabt.
Um den Empfänger im Kopter zu binden, muss der Kopter in den Bindemodus versetzt werden. Dazu 
muss man den Kopter per USB-Kabel mit dem PC verbinden und QGroundControl starten. Dort in die 
PX4 Konsole aufrufen:
Icon Log-Auswertung > Mavlink Konsole.

Man kann sich hier schon allerlei ansehen, zum Beispiel, welche Geräte im Kopter vorhanden sind.
cd /dev
ls

Aber das nur nebenbei. Eigentlich wollten wir den Kopter in den Bindemodus bringen. Dazu an der 
Konsole folgendes eingeben:

typhoon_bind start

Dann auf der ST16 ins Bindemenü gehen, wie gewohnt auf "Refresh" tippen und den angezeigten 
Empfänger wie üblich binden. Fertig.
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Flug Modi

Hochlauf
Dies sind keine eigentliche Flugmodi. Der Kopter ist hier noch am Boden. Um alle Sensoren bereit zu 
haben, sollte man ausreichend Zeit zum Initialisieren geben. Im Flight-Controller läuft ein interner Pre-
Flight Check ab, wo auch Kalibrierungen überprüft werden. Dieser Check kann bei fehlender oder 
falscher Kalibrierung der Sensoren fehlschlagen und der Kopter lässt sich grundsätzlich nicht starten. 
Um festzustellen, was nicht funktioniert, muss der Kopter mit QGroundControl verbunden werden.

Ob sich die Motoren bereits starten lassen, wenn noch kein GPS-Lock gefunden wurde, bestimmt ein 
Parameter: COM_ARM_WO_GPS.

Initialisierung

GNSS und Navigationssystem sind noch nicht bereit und es gibt noch keinen Homepunkt. Man kann 
aber den Start erzwingen und ohne GNSS fliegen, aber es gibt kein RTH bei diesem Flug. The GNSS-
unterstützten Flugmodi werden freigeben, wenn das GPS und der Estimator (Vorausberechnung) bereit 
sind. Das passiert auch im Flug, aber wegen fehlendem Homepoint ist weiterhin RTH nicht verfügbar. 
Ein Homepoint wird erst gesetzt, wenn gelandet und dann wieder gestartet wurde.
Man kann aber Indoor fliegen.
Übergang Acquiring nach Ready passiert nur, wenn der Kopter voll Mission-fähig ist. Der PX4 
Autopilot braucht einige Zeit, alles bereit zu machen, auch wenn schon ein GPS-Lock vorhanden ist.

Status LED: GRÜN blinkend. GPS Statusanzeige "Acquiring", ST16 Statusanzeige "Start".

Bereit (Ready)

Der Kopter ist vollständig navigationsfähig und hat einen Homepunkt gesetzt. Grün wird nicht während
des Fluges angezeigt.

Status LED: GRÜN dauerhaft. ST16 GPS Status wechselt von "Acquiring" zu "Ready", ST16 
Statusanzeige zeigt ebenfalls "Ready". Kopter ist startbereit.

Fehler

Fehlfunktion, Pre-Flight-Check nicht erfolgreich.
Status LED: ROT dauerhaft
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GNSS unterstützte Flug Modi

Alle Sensoren und GNSS müssen fertig initialisiert, einsatzbereit und perfekt kalibriert sein.
Diese Modi sind einfach zu fliegen und lassen Zeit für Steuerung und Überwachung der Kamera.

Mission Modus

Der Thunderbird fliegt vollautomatisch eine vorher programmierte Mission. Das ist der einfachste 
Flugmodus vom selbstständigen Start bis zur automatischen Landung.
Dieser Flugmodus ist in den Parameter-Standardeinstellungen nicht zugeordnet. Für größere Missionen
ist ein Flight Controller mit SD-Karten Slot mit SD-Karte erforderlich.
Anmerkung: Es gibt beim Typhoon H ältere Ausführungen, bei denen der Kartenslot noch bestückt ist. 
Hier kann man problemlos eine SD-Karte einsetzen, die auch sofort erkannt wird.
Ist keine Mission vorhanden, schaltet der Kopter automatisch auf Position Mode.

Status LED: PURPUR blinkend, ST16 Statusanzeige: "Waypoint".

Position Modus

Der Thunderbird fliegt wie ein üblicher Typhoon H im Angle Mode. Zentrierte Steuerknüppel halten 
den Kopter ausbalanciert sowie in x, y und z-Richtung stabil. Das Flugverhalten des Thunderbird ist 
allerdings weicher eingestellt als beim normalen Typhoon H und erfordert mehr Raum für einen 
längeren "Bremsweg".

Status LED: PURPUR dauerhaft, ST16 Statusanzeige: "Angle". 
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Stabilisierte Flug Modi (Stabilized)

Diese Flugmodi verzichten auf GNSS und Kompass bei der Flugsteuerung. Indoor Flüge sind damit 
möglich und magnetische Interferenzen sind kein Problem. Diese Flugmodi erfordern aber volle 
Aufmerksamkeit und Sichtkontakt zum Kopter, sind aber immer noch vergleichsweise einfach zu 
steuern. Der Kopter wird automatisch ausbalanciert, wenn die Knüppel losgelassen werden, hält aber 
nicht die Position.

Altitude Modus (Atti)

Stabilisierter Flugmodus ohne GNSS-Unterstützung. Throttle auf Mittelstellung hält die Höhe konstant.
Throttle steuert die Geschwindigkeit des Steigens oder Sinkens. Der Schub wird automatisch 
angepasst.
Der Thunderbird fliegt sich wie der Typhoon H im Angle Mode ohne GNSS-Unterstützung.
Wenn Position Modus eingestellt und GNSS beim Start noch nicht bereit war, dann wird dieser 
Flugmodus als Rückfallmöglichkeit ausgewählt. 

Status LED: BLAU blinkend. ST16 Statusanzeige: "Angle".

Stabilized Modus

Stabilisierter Flugmodus ohne GNSS-Unterstützung. Keine automatisierte Schubsteuerung. Das 
bedeutet, das Halten der Höhe muss manuell durch entsprechende Kombination Stellung der 
Steuerknüppel in X, Y und Z-Achse eingestellt werden. Mehr Vorwärtsbewegung erfordert zum 
Beispiel mehr Schub. Throttle steuert die Geschwindigkeit in allen drei Achsen. 
Der Flugmodus ist vergleichbar mit "Stabilized" Mode beim Blade Chroma oder Blade 350QX.
Dieser Flugmodus ist in den Parameter-Standardeinstellungen nicht zugeordnet.

Status LED: BLAU dauerhaft, ST16 Statusanzeige: "THR".
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Manuelle Flug Modi (Manual)

Diese Flugmodi sind in den Parameter-Standardeinstellungen nicht zugeordnet. Diese Modi sind sehr 
schwer zu fliegen. Sie erfordern volle Aufmerksamkeit, Erfahrung und natürlich ständig Sichtkontakt 
zum Kopter. Kameras mit Gimbal zur Stabilisierung sollten vorher entfernt werden.

Rattitude Modus

"Assisted Acrobatics", eine Kombination aus Stabilized Modus und Acro Modus. Loslassen der 
Steuerknüppel sollte die Fluglage des Kopter stabilisieren, wenn genug Höhe und Schubkraft dafür 
vorhanden sind. Bis zu einen (einstellbaren) Schwellwert der Stellung der Steuerknüppel wird sich der 
Kopter wie bei Stabilized oben beschrieben verhalten. Wird der Steuerknüppel weiter gezogen, dann 
wird Acro-Modus eingestellt und es sind Flugtricks wie Rollen oder Loopings möglich.
Status LED: WHITE purpur blinkend, ST16 Statusanzeige: "Rate".

Manual, Acro or Rate mode

Die Steuerknüppel kontrollieren die Winkelbeschleunigung. Es erfolgt keine automatische Ausrichtung 
des Kopter und kein Stoppen mehr. Der Schub wird direkt umgesetzt. Es gibt absolut keine 
Unterstützung vom Flight Controller (Autopiloten) mehr, die Sensoren sind abgeschaltet. Es werden 
nur noch die Gyro-Daten verarbeitet.
Der Flugmodus erlaubt alle Arten von Flugmanövern.
Der Flugmodus ist vergleichbar mit "Agility" Mode beim Blade Chroma oder Blade 350QX.

Status LED: WEISS dauerhaft, ST16 Statusanzeige: "Rate".

Vorsicht mit Acro oder Rattitude Modus! Lerne erst Stabilized Modus fliegen.

Fail-Safe Modus

Fail-Save kann entweder manuell eingeleitet werden (Return To Home – RTH) oder automatisch durch 
den Autopilot. Automatische Fail-Save Modi werden durch Parameter eingestellt.

Fail-Safe aktiviert, RTH eingeleitet oder Kopter versucht automatisches Landen an Ort und Stelle bei 
GNSS-Fehler.
Status LED: ROT blinkend.
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Status LED Anzeigen am Kopter (Heck LED)

Grundlegende Regeln unabhängig von derFarbkodierung

1. Wenn die Status LED dauerhaft leuchtet, hat der Pilot die volle Kontrolle.
2. Wenn die Status LED blinkt, greift der Autopilot aktiv in die Flugsteuerung ein (Position halten,

Höhe halten und so weiter).
3. Rot bedeutet RTH, Probleme oder Fehler.

RGB Status LED Details

Grün: Hochlauf
GRÜN blinkend: GPS Statusanzeige "Acquiring", ST16 Statusanzeige "Start". GNSS und sind
noch nicht bereit, kein Homepunkt gesetzt.

GRÜN dauerhaft: ST16 GPS Status wechselt von "Acquiring" zu "Ready", ST16 
Statusanzeige zeigt ebenfalls "Ready". Kopter ist startbereit.

Purpur: GNSS unterstützte Flüge
PURPUR blinkend: Mission mode. ST16 Statusanzeige: "Waypoint".

PURPUR dauerhaft: Position mode. ST16 Statusanzeige: "Angle". 

Blau:  Stabilized flight
BLAU blinkend: Altitude mode. ST16 Statusanzeige: "Angle". 

BLAU dauerhaft: Stabilized mode. ST16 Statusanzeige: "THR".

Weiß: Manual flight modes
WEISS purpur blinkend: Rattitude Modus oder "Assisted Acrobatics".

                                                        ST16 Statusanzeige:  "Rate".

WEISS dauerhaft: Manual-, Acro- bzw. Rate Modus. ST16 Statusanzeige: "Rate" (ungetestet).

Rot: Fail-Safe, RTH, Fehlfunktion, Fail-Safe
ROT blinkend: Der Kopter hat eingeschränkte Funktionalität, fliegt aber weiter, kann gesteuert
werden und versucht sich zu fangen. Die LED blinkt rot wenn Fail-Safe aktiviert ist, also RTH 
oder bei fehlendem GPS automatische Landung. Die LED-Statuslampe kann von Zeit zu Zeit 
zwischen Rot und der vorherigen Farbe umschalten. In diesen Fällen ist es immer angeraten, 
den Kopter zu sich heranzuholen soweit das möglich ist.

ROT dauerhaft: Fehlfunktion, Motorstart nicht erlaubt. ST16 Statusanzeige: "EMER".
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Parametereinstellungen

Die Parametereinstellungen müssen mit QGroundControl vorgenommen werden. Geänderte Parameter 
werden nicht im Modell auf ST16 gespeichert. Es wird empfohlen, die Parameter in einer Datei zu 
speichern, bevor etwas geändert wird (Speichern und laden von Parametern – siehe weiter unten).
Schreibe auf welche Parameter du geändert hast und warum (siehe Blatt zur Parameteränderung im 
Anhang). Die gespeicherte Parameterdatei ist eine Sicherung und kann verwendet werden, um im Fall 
von Problemen oder unerwartetem Verhalten alle früheren Parametereinstellungen wiederherzustellen.

Parameter ändern
Schalte den Kopter ein und verbinde diese über USB mit QGroundControl.
Gehe zu Einstellungen (Symbol mit Zahnrädern) > Parameter. Parametereinstellungen werden nach 
ihrer Funktionalität gruppiert.
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Um einen Parameter zu finden benutzen, kannst du die Suchfunktion verwenden können.

Klicke auf den Parameter, den du ändern willst. Der Parametereditor wird rechts angezeigt.

Den Parameter ändern (aus Liste auswählen oder Wert eingeben) und Speichern. Einige Parameter 
erfordern einen Neustart des Kopters. Dies wird ebenso wie andere Hinweise angezeigt.
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Parametereinstellungen speichern

Gehe zu Einstellungen (Symbol mit Zahnrädern) > Parameters > Tools > Save to file... Gib einen 
sinnvollen Dateinamen ein (z. B. mit Datum oder Grund) und speichere. 

Parameter von Datei laden

Die Parameterdatei aus der letzten Sicherung kann verwendet werden, um die Parametereinstellungen 
für den Fall wiederherzustellen, dass es Probleme mit neuen Einstellungen gab.
Gehe zu Einstellungen (Symbol mit Zahnrädern) > P> Parameters > Tools > Load from file... 
Parameterdatei auswählen und die letzte Einstellung der Parameter auf den Kopter hochladen. Es muss 
danach ein Neustart des Kopters durchgeführt werden, um die Einstellungen wirksam werden zu 
lassen.
Überprüfe danach auch die Kompassausrichtung abhängig vom Kompasschip und führe eine komplette
Kalibrierung durch. Kalibrieungsdaten gehören auch zu den Parametern und werden hier 
überschrieben.
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Firmware Update Prozedur für Ubuntu LINUX

Vorbereitung
Folgende Dateien in ein eigenes Verzeichnis kopieren:

flash_typhoon_bootloader
px_uploader.py
yuneec_typhoon_h.fw         (Beispielhafter Dateiname für die Firmware)

Mit folgenden Befehlen kann man feststellen, welcher Port benutzt wird. USB-Kabel ab- und wieder 
anstecken.

dmesg | grep usb
dmesg | grep tty

Mit dem ersten Befehl sieht man, welche USB-Geräte als letztes erkannt wurden.
Mit dem zweiten Befehl sieht man die Reaktion des entsprechenden tty-Ports mit gleichem 
Zeitstempel. 

Der gesuchte Port ist hier "ttyACM0".
Was man auch sieht, dass nach dem Einschalten der Bootloader startet und danach die Autopilot 
Software. Wenn der Autopilot bereits gestartet ist, kann man nicht mehr Flashen. Deshalb ist es 
wichtig, das Script zum Flashen schon zu starten, wenn das MCU-Board noch stromlos ist. Es wird erst
nach dem Anstecken des USB-Kabels mit Strom versorgt und dann erwischen wir den Bootloader.
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Autopilot flashen
Nun müssen wir mit einem Texteditor die Datei "flash_typhoon_bootloader" editieren, um den Port und
den Dateinamen der  Firmware einzustellen. Die Textdatei sollte dann etwa so aussehen:
python px_uploader.py --port /dev/ttyACM0 --force yuneec_typhoon_h.fw

Ein Terminal öffnen. In das Verzeichnis wechseln, wo man die drei Dateien hineinkopiert hat und die 
Scripte ausführbar machen.

chmod +x ./flash_typhoon_bootloader
chmod +x ./px_uploader.py

Sicherstellen, dass USB Verbindung zum Kopter getrennt ist und keine Batterie im Kopter ist (MCU-
Board stromlos). Die Stromversorgung des MCU-Boards kommt dann über USB. 

Update Prozess starten:
./flash_typhoon_bootloader

Sofort danach die USB Verbindung zum Kopter herstellen. Warten, bis es losgeht und den Update 
Prozess beobachten.

Kopter nach erfolgreichen Flash-Vorgang neu starten.
Danach unbedingt alles prüfen und kalibrieren wie für einen neuen Kopter üblich.
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Firmware Update Prozedur für Windows

Vorbereitung

Folgende Dateien in ein eigenes Verzeichnis kopieren:
flash_typhoon_bootloader
px_uploader.py
yuneec_typhoon_h.fw         (Beispielhafter Dateiname für die Firmware)

Installiere Python für Windows, wenn es noch nicht vorhanden ist. Dazu öffnen wir die Windows 
Terminal App. Gib dort python ein, um zu prüfen, ob Python bereits installiert ist.

Wenn nicht, öffnet sich der Windows Store und bietet Python Installation an. Folge den Anweisungen 
um Python zu installieren.

Wenn Python richtig installiert ist, dann startet es im Terminal mit seiner eigenen Kommandozeile, 
beginnend mit: >>>.

Diese Umgebung kann man mit exit() verlassen.

Wir brauchen noch das Modul 'serial' für Python::
https://pypi.org/project/pyserial/#files

Doppelklick auf "pyserial-3.5-py2.py3-none-any.whl", um das Modul zu installieren.

Nun ist Python installiert und wir können Scripts wie "px_uploader.py" ausführen.
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Um herauszufinden, welcher serielle Port benutzt wird, öffnen wir den Gerätemanager:
Gib: devmgmt.msc ein.

Der Gerätemanager erscheit. Verbinde den Kopter per USB-Kabel USB mit dem PC. Bei "Anschlüsse 
(COM & LPT)" erscheint eine neue Zeile "Legacy FMU" mit einer COM Port Nummer.

Hier im Beispiel "COM8".

Diesen COM Port müssen wir mit einem Texteditor in "flash_typhoon_bootloader" eintragen und als 
"flash_typhoon_bootloader.bat" speichern. Außerdem muss eventuell der Name der Firmware-Datei 
korrigiert werden. Die Textdatei sollte dann etwa so aussehen:
python px_uploader.py --port COM8 --force "yuneec_typhoon_h.fw"

Autopilot flashen

Hinweis: Nach dem Einschalten startet der Bootloader und danach die Autopilot (Flight Controller) 
Software. Wenn der Autopilot bereits gestartet ist, kann man nicht mehr Flashen. Deshalb ist es 
wichtig, das Script zum Flashen schon zu starten, wenn das MCU-Board noch stromlos ist. Es wird erst
nach dem Anstecken des USB-Kabels mit Strom versorgt und dann erwischen wir den Bootloader.
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Sicherstellen, dass die USB Verbindung unterbrochen ist (MCU-Board ausgeschaltet).

Starte Firmware Update Script im Windows Terminal:
flash_typhoon_bootloader.bat

Jetzt USB-Kabel stecken. Warten bis Flashen startet und die Flashprozedur im Terminal beobachten.

Erledigt!
Kopter nach erfolgreichen Flash-Vorgang neu starten.

Danach die Parameter neu laden, entweder deine Sicherung oder die mitgelieferte Default-
Parameterdatei.
QGroundControl > Vehicle Setup > Parameters > Tools > Load from file… > Parameterdatei 
auswählen.

Danach ist ein erneuter Neustart erforderlich.

Nun unbedingt alles prüfen und kalibrieren wie für einen neuen Kopter üblich.
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Anhang

Empfohlene Parameter
Parameterbeschreibungen: https://docs.px4.io/v1.9.0/en/advanced_config/parameter_reference.html

Parameter von nach Beschreibung

MPC_Z_VEL_MAX_DN 1.000 3.000 Max. Sinkgeschwindigkeit [m/s] wie beim H480

MPC_Z_VEL_MAX_UP 3.0 5.0 Max. Steiggeschwindigkeit [m/s] wie beim H480

MC_RATT_TH 0.80 0.60 Schwellwert für Stabilized in Rattitude mode [%] für 
mehr Acro-Anteil für schönere Rollen oder Loopings

COM_ARM_WO_GPS Disabled
(0)

Enabled
(1)

Motorstart ohne GPS-Lock möglich. Für Flüge mit 
GNSS-Unterstützung warte auf dauerhaft grün 
leuchtende Status-LED.

RTL_RETURN_ALT 30m x RTH Mindesthöhe: Lasse 30m stehen oder trage hier 
einen Wert x ein, der besser zu deinem Fluggebiet 
passt.

Flight Modes:

QGroundControl > Flight Modes > Flight Mode Settings:
Mode Channel = Channel 5
Flight Mode 6: Ändern von Stabilized zu Altitude. Altitude Mode verhält sich wie der Typhoon H mit 
abgeschaltetem GPS.

QGroundControl > Flight Modes > Switch Settings:
Return Switch Channel: Ändern von Unassigned zu Channel 10. In dem Falle ist S2 Pan Mode in der 
untersten Position RTH. Diese Schalterstellung überschreibt alle anderen Flight Modes. 

Achtung:
• Nach Änderungen teste alle Flight Modes ohne Propeller bevor du diese bei realen Flügen 

benutzt.
• Alle Tuning-Maßnahmen und Parameter Einstellungen können das Flugverhalten beeinflussen 

und ein Sicherheitsrisiko bedeuten. Bitte tue es auf eigene Verantwortung und nur wenn du 
weißt, was du tust.

Version 1.1 von 2022-04-21 Seite 24/30

https://docs.px4.io/v1.9.0/en/advanced_config/parameter_reference.html


Einige hilfreiche Kommandos an der MAVLink Konsole

Die MAVLink Konsole öffnet eine PX4 NSH Kommandozeilenumgebung. Der Kopter muss mit 
QgroundControl verbunden und hochgefahren sein.

Mehr über die NSH shell hier: https://dev.px4.io/v1.9.0/en/debug/system_console.html

Hilfe

? Zeigt eine Liste von Kommandos und Build-in Apps:

Die Shell Kommandos sind hilfreich bei Fehlersuche und um sich Kenntnisse über das System zu 
beschaffen. Mehr Informationen siehe PX4 Autopilot Dokumentation und QGroundControl Manual.
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Folgende Kommandos können ohne Bedenken ausgeführt werden. Sie dienen nur zum Auslesen und 
verändern nichts.
Wie das Kommando typhoon_bind siehe Kapitel „ST16 mit dem Empfänger SR24 im Kopter 
binden“.

Dateisystem

ls Auflisten von Dateien und Verzeichnissen
cd fs/microsd Wechsle zur Dateiliste auf der SD-Karte
ls -l Zeige Dateien und Verzeichnisse auf der SD Karte
cd / Gehe zurück zum Wurzelverzeichnis

Mit den oben beispielhaft gezeigten Kommandos kann man prüfen, ob man eine SD-Karte auf dem 
Flight Controller hat und wenn ja, was da darauf ist.

Zum Downloaden von Flight Logs (ULOG files: *.ulg) sollte man QGroundControl Analyze > Log 
Download nutzen. Klick auf Refresh um die Liste der ULOG Dateien zu erneuern.
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Geräte

ls Auflisten von Dateien und Verzeichnissen
cd dev Wechsle zum Geräteverzeichnis ‘dev’
ls Auflisten der Geräte und Anschlüsse
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System

df Speichergröße
df -h Speichergrößen im besser lesbaren Format
free Zeigt freien und benutzten Speicher
date Zeigt Systemzeit
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Parameter Nachweisblatt

Es ist empfehlenswert, die Änderungen von Parametern und die Historie aufzuzeichnen. Dies hilft 
später bei fehlersuche, wenn etwas nicht wie erwartet funktioniert.

Hiweis  :   Channel Settings der ST16 sind im Model in der ST16 gespeichert.
Parametereinstellungen in QGroundControl sind dagegen nicht im Model auf der ST16 gespeichert. 
Parameter können aber in eine Datei gesichert und wieder hochgeladen werden.
Bei Parameteränderungen ist eine vorherige Sicherung sehr zu empfehlen.

Datum Parameter alt neu Beschreibung/Grund
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Spickzettel
Vorschlag eines Kurzinfoblattes zum Ausdrucken und Mitführen.

Flight Mode Einstellungen (trage hier deine Einstellungen ein)

FlightMode Switch Position

Position (Angle mode) Flight Modus Schalter S4 Mitte

Altitude (GNSS 
Unterstützung aus)

Flight Modus Schalter S4 oben

Stabilized (Manual) S4 + Aux Schalter B2 oben

Rattitude S4 + Aux Schalter B2 unten

Acro

Mission Flight Modus Schalter S4 unten

RTH Pan Modus Schalter S2 unten

Ein- und Ausschalten

Power on:  Power Knopf für ~ 8s drücken bis LEDs angehen.
                   Der Geschwindigkeitssteller muss auf „Hase“ stehen!
Power off: Batterie entfernen

Motor Start / Stop

Throttle Stick (in Mode 2 linker Steuerknüppel) unten rechts halten

Flying

✔ Prüfe Standort (Regeln und Gesetze)
✔ Freier Raum zum Empfang der GBSS Signale vorhanden? Keine 

potenziellen Reflektorflächen, um Multi-Path-Empfang zu vermeiden.
✔ Flugbatterie voll, ST16 Batterie voll?
✔ Prüfe ständig Batteriespannungsanzeige während des Fluges.

Kopter binden: nsh shell Kommando "typhoon_bind start"
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